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 What do you need to be designed?     




 
   
 				         
						
						 
                       


Logo Design - Ready


ReadyMade Logos
 
Our Ready Made logos stand out as the best in the online design market.

 
 Ready Logos  Buy Now  






 Design -    Items 
 

Design Items
 
Design items for creators and professionals, designers and creatives.  



 Logo Creator Premium 
Mobile Design Creator Full & Free 
Screen Design Creator Full & Free




 


                       
                       
                       
					    

                        
                        
                        
                        
                        
 



 Logo  Design 


Logo Design
 
The best and most suitable logo design for companies and businesses, startups and entrepreneurs.


 Logo Design 
Custom Logo 
Product Logo 
ReDesign Logo 
Logo from Sketch

  Order Design    
  Buy   







 				    
						 
                        
                   
 
						
           
           
					
                    
                    
                        
                       
                        
 




 Design -   Services 
 

Design Services
 
Design services for companies and businesses, startups and entrepreneurs. 

 

   Identity Design 
  Branding 
  ReBranding  
  Apps Design  
  Websites Design 


 The Brand 
 Inspirations 
 Guide 


  
                      
    
    
    
    
    
    
                       

                       
                       
					
						
 


  Entrepreneurs   Studio  
 

Entrepreneurs Studio
 
The Power of Design & Branding for entrepreneurs, and business owners. 







How can we help you? 



 Contact 

Get in touch with us.  

Let’s work together!


  About   
  Advantages   


 Customers 
Portfolio  
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 Mobile Design Creator   Full & Free  
  
 Create branded graphic design for iOS and Android mobile devices. Phones, Tablets, Watches. 

 


 PREMIUM DESIGN  by 

 


  Start Creating! 


  











   The Creator   Mobile Design Creator 


 
  Logo Design for startups and entrepreneurs  




 

 
 








 
  











    
    

      

 


   Create branded graphic digital design for mobile devices. 
 
 Make icons, touch icons, favicons, launch screen, splash screen, startup screen, digital wallpapers and test screen images for iOS and Android mobile devices. 
 

 
    Build a complete brand image on all your customer’s mobile devices.  

Design branded mobile screen images for your customers to add theirs brand design to all theirs organisation’s mobile devices.    



 
  Let’s get to work!   

    
 
  Free Download from Google

 
  Free Download from Box



 

















    How it Works  Mobile Design Creator  




 
 Graphic digital design for mobiles. Perfectly done. 


 The  Mobile Design Creator graphic digital content will help you save hundreds of hours of manual, repetitive, math needed work.  The Mobile Design Creator graphic digital content, graphic items and editable files are designed and made to have the exact sizes, the perfect resolutions and the right names requested by iOS and Android standards.




 

 Create iOS and Android Icons. 

 All icons formats will be saved with required name and dimensions. 

Easily and quickly.  Just place your design and save.   








 


 Create all Icons at required name and dimensions in a snap.  

 * Mobile Design Creator uses features such us smart symbols, smart objects, saving or exporting automatically to required size and name. To use these features, it is necessary to use the Adobe Illustrator or Photoshop software.
 
  iOS.App.Icons Creator  

  Android.App.Icons Creator  

 are available for both Adobe Illustrator and Adobe Photoshop.


 Adobe Illustrator .ai template. Edited in Adobe Illustrator CS6 works with various versions of Adobe Illustrator. 
The editable .ai template will automatically save the icons with required name and dimensions. 


	Icon Design / Edit Smart Symbol - that will propagate to all other dimensions.  

	Double click to edit symbol / Edit - Icon Design and Background Color. Replace the Symbol with your design. 
	Save Settings for .ai Adobe Illustrator: 

	File > Export 

	Format > .png 

	CheckBox > Use Artboards 

	All icons formats will be saved automatically with required name and dimensions.

   

 Adobe Photoshop .psd template. Edited in Adobe Photoshop CS6 works with various versions of Adobe Photoshop.  
The editable .psd template will automatically save the icons with required name and dimensions. 

	Icon Design / Edit Smart Object - that will propagate to all other dimensions.  

	Double click EDIT DESIGN layer thumbnail to Edit Smart Object EDIT DESIGN. Replace the Smart Object with your design. 
	Save Settings for .ai Adobe Photoshop: 

	File > Save for Web 

	Format > Images Only 

	Settings > Default Settings 

	Slices > All User Slices 

	All icons formats will be saved automatically with required name and dimensions. 

   
    

   That's it.   





 Create branded digital content for iOS and Android mobile devices. 

 Create Launch Screen, Splash Screen, Startup Screen and the most useful wallpaper images iOS and Android mobile devices. All design formats will be saved with required name and dimensions. 

  iOS.Branded.Screens Creator — Create branded digital design, iOS mobile devices. 

  Android.Branded.Screens Creator — Create branded digital design, Android mobile devices.

 




 Simple to use   Impressive when used.  

Select and place created screen image that fit the device screen size. 

Use the  Phone.Screen.Sizes.pdf to find screen dimensions for popular smart phones and mobile devices.


	 Send the screen image to mobile device, using messages apps or by email. 
	 Save the screen image, locally, on mobile device. 
	 Go to device's settings / wallpaper and place the image as new wallpaper. ( lock screen / home screen ). 




 
 Tips. Play. Invent.  

	 Create branded screen images with organisation's brand identity for all your customers. 
	 Create launch screen images for websites. 





Create iOS wallpaper images in   Still or Perspective 

 Still wallpaper - is a standard wallpaper image for iOS screen.

 Perspective wallpaper - moves the wallpaper image slightly as you move the device to give the illusion of depth(3D).

  iOS.Launch.Splash.Startup.Still.Wallpaper.Screens Creator 

  iOS.Perspective.Wallpaper.Screens Creator 









 
Test screen images for mobile devices.

Create branded test screen or use our ready made.


Quickly and easily test/check mobile device display screens for iOS and Android devices. Simply find out whether the mobile device has a perfectly functional display screen. 


 Test screen images  - Primary Colors. Ready to be used. 

 Only one color should be seen. No pixel of any other color should be seen on the screen. Find that lazy pixel with perfect colors: white, black, red, green, blue. 

  Mobile.Test.Screen.Full.Color 


 Test screen images  - Patterns. Ready to be used. 

 Straight, visible lines, exact proportions and dimensions kept on the entire screen. 
 Colors do not have to mix. Color Bars SMPTE / T  

  Mobile.Test.Screen.Patterns 



  Editable  - Test screen images for iOS and Android mobile devices. 

 Create, design, edit your own test screen for iOS and Android mobile devices. 

Create a brand new design for you or for your customers. 

Play.

  Mobile.Test.Screen.Editable 



 


 Simple to use   Impressive when used.  

Select and place a screen test image that fit the device screen size. 

Use the  Phone.Screen.Sizes.pdf to find screen dimensions for popular smart phones and mobile devices.


	 Send the screen test image to tested device, using messages apps or by email. 
	 Save the screen test image, locally, on tested device. 
	 Use an image viewer app or device default photos image app to view the screen test image. Set the image size at full screen size.  




 
 Tips. Play. Invent.  

	 	Create branded screen test image and use it as wallpaper background for your mobile devices. 
	 	Create screen test images branded with organisation's brand identity for all your customers. 
	 	Test any new mobile device with  Mobile.Test.Screen.Full.Color screen test images. 







  Digital Graphic Design Items   Creative Files  

Create branded design with your prefered drawing software.    
 
 Mobile Design Creator  is a digital package that contains graphic design items and creative files. To create and edit design works with this digital graphic package you'll need a vector or raster drawing software. With perfect final results, can be used both free or paid versions of drawing softwares. Also:), you can download and use paid software in free trial period. Please, have a quick look for a proper   software and files compatibility. 
 Create, design and edit the files with your own drawing editing software or choose from paid or free   Drawing Software versions . 




 
 

* Mobile Design Creator uses features such us smart symbols, smart objects, saving or exporting automatically to required size and name. To use these features, it is necessary to use the Adobe Illustrator or Photoshop software. 


 Professional editable files: 
 
  Mobile Design Creator files are available for both Adobe Illustrator  and Adobe Photoshop.  

 * Maximum compatibility for Adobe versions.  

Logo Creator is build and edited in Adobe Illustrator CS6, Adobe Photoshop CS6 .

 Adobe Illustrator   / .ai / .eps / .pdf / .psd / .svg / .ps / (vector layered)    

 Adobe Photoshop     / .psd /(vector layered shapes/path),   / .png / .jpg / (raster files)
 


 Digital Files. 
 
  Mobile Design Creator digital files are available in all universal vector formats and works with some of drawing softwares.  *To use special design features such us smart symbols, smart objects, saving or exporting automatically to required size and name, it is necessary to use the Adobe Illustrator or Photoshop software. 

  Vector, shapes/path, fully editable:  / .ai / .eps / .pdf / .psd / .svg / .ps /   

  
  
    Works with:  /  Adobe Illustrator    (Mac, Win)  /  Adobe Photoshop    (Mac, Win) 	/  Affinity Designer (Mac, Win) / Graphic (Mac) / Corel Draw (Win) / Sketch (Mac) / Inkscape  Free (Mac, Win, Linux) / Gravit Designer  Free (Mac, Win, Linux, Chrome OS, Browser) /  Vectr  Free  (Mac, Win, Linux, Chrome OS, Browser) .  
  


  Discover a comprehensive list of drawing softwares:  

   Vector Editing Software    and the
   Vector file type software compatibility  .










  Extra amazing files?     Yes, Please!  What's inside?  

  Website.Favicon Creator   Complete.  

      Create icons, favicons and touch icons for websites and web apps in a snap.   Website.Favicon Creator helps you easily and quickly create, all the icons, favicons and touch icons required by  desktop browsers and mobile browsers  for websites and web apps.  
 
* Website.Favicon Creator uses features such us saving or exporting automatically to required size and name. To use these features, it is necessary to use the Adobe Illustrator or Photoshop software.

  Website.Favicon Creator 





 All icon formats will be saved with required name and dimensions. 

  Website.Favicon Creator   Take a look. 




  Extra,   extra amazing files?      ::: Y. - Yeees! :::  


 
 

 Logo Creator  Lite     


Create the best and the most suitable logos for startups, entrepreneurs, companies and businesses. Create professional logos from modularly designed digital graphic items. Everything is built and works simple and it fits with any creative design project. Logo Creator complete design package contains thousands of digital graphic items, and  more than a hundred of ready made logos, created, designed and edited in an authentic, memorable style that fits all business types. 


  Logo Creator.Lite  *   version contains some of logos and graphic design items that are part of the complete  Logo Creator  design package.












 


 Screen.Design Creator  Lite  

 Create branded and useful digital graphic design for desktop devices. Laptop, desktop and TV devices. Create branded graphic digital design using smart digital grid screen systems. Create useful digital wallpaper background designs and test screen images for Mac and Win, laptop, desktop and TV devices. The Screen.Design Creator graphic digital content will help you save hundreds of hours of manual, repetitive, math needed work. 

  Screen.Design Creator.Lite  *   version contains some of the graphic design items that are included in the complete  Screen.Design Creator  design package.















  Design better and faster with Mobile Design[+]Creator.  

 Modularly designed graphical elements helps you create breathless and speechless designs adding a real, tangible value to your works. Focus on your idea, unleash your creativity and create the best design ever made. 

   Mobile Design Creator is Modularly Designed   



  



    How can we help?    
     Contact us.  




  
   Review & Like   

If you enjoy using  Mobile Design[+]Creator,      please share a nice review. It really helps! 



   Thank you!   





  Let’s get to work!  

 Unleash your creativity!  






 





  







 
 

 

  
  
   
  




 














 

   Mobile Design[+]Creator   








  Unleash your creativity  
 Design better and faster.  Create and design like a pro.  

Let’s get to work! 
  Start Creating!


 


  Free Download from Google



  Free Download from Box




 


 
	 Create high quality works. 
	  Design better and faster. 
	  Create with limitless possibilities. 
	  Increase productivity.  
	  Save time.  









   The Creator 

  Logo Creator 

  Mobile Design Creator

  Screen Design Creator









 









 




 



 

 



  

    
    
    













   
 


 
  
 
  








 You are 



 Start Creating!  

  Let’s get to work!  





 PREMIUM DESIGN  by  









  













            
 















 

 


 
   





    Talk   
 
Exchange creative ideas and request new design content related to Mobile Design[+]Creator graphic resources.

    Mobile Design[+]Creator    Talk      
 





   News  

Stay tuned ! Get the latest graphic design resources and product upgrades.

     News    
 












  










   










 
  The Creator  
  Logo[+]Creator 
  Mobile.Design[+]Creator
  Screen.Design[+]Creator


  Website.Favicon[+]Creator  
  iOS.App.Icons[+]Creator  
  Android.App.Icons[+]Creator  
  Google.Display.Ads[+]Creator  
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 Made with  by Creator.Design® | Copyright   2024        . 
 All rights reserved. 
 |
 Licenses  | 
 Privacy  | 
 Terms  | 
 Sitemap  |   

Creator.Design® is a registered trademark and is under the protection of intellectual property rights legislation. 
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